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Installing Flash and Setting
Your Preferences

Installing Flash is simple. Nevertheless, sometimes a few pointers can help.
And after you're up and running, you might want to customize how Flash
works. You can set quite a number of preferences. You can also create your
own keyboard shortcuts.

Now, time to stop stalling and start installing.

Installing Flash

Installing Flash is a cinch, although you have a few options. Here’s the
lowdown on getting started. You can install Flash in four different ways:
v~ Install it from a DVD (onto a PC).
1 Download it to a PC.
»~ Install it from a DVD (onto a Mac).

» Download it to a Mac.

We discuss these methods separately in the next four sections.

Installing Flash onto a PC from a DUD

So you went out and bought Flash in the box, and you have a DVD drive on
your PC. To install Flash from the box, follow these steps:

1. Exit all Windows programs.
2. Insert the DVD.

In most cases, the setup program starts automatically. If it doesn’t,
choose Start>Run in Windows XP and click Browse. Then find and
double-click setup . exe on your DVD drive. Click Run. In Windows
Vista, choose Start and type setup.exe in the Start Search text box.
Find the setup . exe file on your DVD drive and double-click it.
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3. Follow the instructions on the various screens that appear.

Unless you want to save space by not installing the lessons and samples,
choose the typical installation. Other than that, the most significant
choice that you have is where you install Flash. You can browse to
change the location or accept the default, which is C: \Program
Files\Adobe\Adobe Flash CS4.

4. When the setup program has finished copying files, click Finish.
5. Read the ReadMe file offered on the last screen.

Although we guarantee that most of the stuff in the file is irrelevant to
you, sometimes this file has just the weird detail that applies to your
situation, so take the two minutes to read it.

Installing Flash by downloading it to your PC

If you like, you can download the Flash trial directly from the Adobe Web site.
You can then pay for it within 30 days or it stops working. Follow these steps:

1. Go to www.adobe.com/downloads.
2. From the list of Adobe products, select Flash CS4 Professional.

3. Follow the instructions on the screen for downloading the
installation file.

When you download the file, you select a location on your hard drive. If
you have a Downloads folder, you can use that. Another good option is
the Desktop. Remember the location you choose.

4. When the download is complete, double-click the installation file.

Here’s where you need to remember where you saved the file. The instal-
lation program guides you through the process of installing Flash.

5. If you're given a choice of installation types, you probably want to
choose the typical installation.

The only other significant choice you have is where you install Flash.
You can browse to change the location or accept the default, which is
C:\Program Files\Adobe\Adobe Flash CS4.

After you install Flash, you can play with it! You can buy it at any time by
clicking Buy A Serial Number for Adobe Flash CS4 Online on the first screen
you see when you open Flash. Clicking this link takes you to a Web site where
you can buy a serial number for Flash. After you purchase the serial number,
you can run Flash again if you closed it, and enter the serial number on that
first screen.

Installing Flash onto a Mac from a DVD

If you bought Flash in a box, use your DVD drive to install the program. To
install Flash on your Mac from a DVD, follow these steps:
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. Insert the DVD.

An installer icon appears on your desktop.

2. Double-click the Flash CS4 Installer icon.

. When a window appears, displaying a software license agreement,

click the Accept button so that you can continue the installation.

Of course, being the responsible people we are, we recommend reading
the license agreement.

. Unless you want to save space by not installing the lessons and sam-

ples, choose the Easy Install option, which is the default.

Other than that, the most significant choice you have is where you
install Flash. You can browse to change the location or accept the

default location, which is in the Applications folder on the startup

disc drive.

. Click Install.

The installer program starts copying files. When it’s finished, you see
the Adobe Flash CS4 folder displayed on your computer screen, contain-
ing the Flash CS4 program, a few documents, and a bunch of other fold-
ers. One of the documents is the ReadMe . htm file. You can view the
contents of this file by double-clicking it. Although most of the stuff in
the file is irrelevant to you, sometimes the file has a detail that applies
to your situation, so reading it can be worthwhile.

Installing Flash by downloading it to your Mac

In this ultramodern day and age, you can install Flash on your computer

without ever leaving your Web browser. To download Flash, follow these

steps (or something like them, assuming that the Adobe Web site doesn’t
change too much):

1.
2.

Go to www.adobe.com/downloads.
From the list of Adobe products, select Flash CS4 Professional.

You need to choose a geographic location, complete or create a
password, and answer a few questions.

. Follow the instructions on the screen for downloading the

installation file.

. When the download is complete, find and double-click the

installation file.

. Follow the instructions on the various screens that appear.

The installation program guides you through the process of installing
Flash. The most significant choice you have is where you install Flash.
You can browse to change the location or accept the default, which is
the Applications folder on the startup disk drive.

o
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After you install Flash, you can play with it for 30 days before it stops work-
ing. You can buy it at any time by clicking Buy a Serial Number for Adobe
Flash CS4 Online on the first screen you see when you open Flash. Clicking
this link takes you to a Web site where you can buy a serial number for Flash.
After you purchase the serial number, you can run Flash again if you closed
it, and enter the serial number on that first screen.

Setting Your Preferences

Flash offers numerous ways to customize how you work. Why not make Flash
suit you? The main location for setting preferences is the Preferences dialog
box, shown in Figure BC-1, with the General category displayed by default.
To open the Preferences dialog box, choose Edit~>Preferences (Windows) or
Flash >Preferences (Mac). The following sections describe how to use this
dialog box.

All the figures in this chapter are Mac screenshots. The Preferences in
Windows are quite similar.

Preferences

Category Ceneral

General
setionSeript —
Ao Form at oOn launch: = Welcome Screen
Clipboard

Drawing

Texn Ul Document-level Undo
Wamings

PSD File Im porter
& File Importer

Warkspace

Selection;

Timelina:

Highlight colar:

= |®|Drawing objects

M| Drawing primitives.
| Groups

| Symbols

W Other elements

Version Cue Enable Version Cue

Figure BC-1: Use the Preferences dialog box to bend Flash to your will.
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General category

Click the General category to set the following options:

» On Launch: When Flash opens, it can show a welcome screen that
gives you options of opening an existing document or starting a new
one. This is the default, but if you find the welcome screen useless, you
can choose to always start a new document, open the documents that
you were using the last time you used Flash, or start with no document
and decide where to go from there.

 Undo: Here you choose whether you want to use object-level or
document-level undo (as we explain in Chapter 4). Then choose the
number of actions you want to keep. The text box is set to 100 by
default; you can enter any value from 2 to 300. The higher the value,
the more RAM Flash uses to remember all those steps. You might be
surprised by how many commands you give in a short period of time, so
100 or more is probably a good setting. However, if you want to save
commands from steps in the History panel, set the number of actions
higher.

1 Workspace — Open Documents in Tabs: (For Mac only.) This option is
marked by default so that new documents open in a single window with
tabs. Deselect this check box if you want each new document to open in
a separate window.

1~ Workspace — Open Test Movie in Tabs: By default, Flash opens a new
window to play your movie when you test it. Select this check box to
instead open a new document tab (like the ones Flash creates for each
open document).

1 Workspace — Auto-Collapse Icon Panels: In the Flash workspace, you
can collapse a panel to an icon by clicking the gray header bar at the top
of a palette dock. Then clicking the icon makes the palette appear. The
panel disappears automatically when you click anywhere outside the
panel if the Auto-Collapse Icon Panels preference is enabled (which it is
by default).

1~ Selection — Shift Select: This option is enabled by default. [t means that
you have to press Shift to select more than one object (by clicking). If
you don’t press Shift, the first object is deselected. Clearing this option
means that you can click as many objects as you want to select them.
This method is an efficient way to work, but most people aren’t familiar
with it. If you select something by accident, press Shift and click the
object to deselect it.

1 Selection — Show Tooltips: By default, this option shows short explana-
tions of Flash interface features (such as toolbars and buttons) when
you hover your cursor over them. You can make these tooltips go away
by deselecting this check box.

o
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1~ Selection — Contact-Sensitive Selection and Lasso Tools: By default,
you need to completely surround objects with the selection or lasso
tools to select them. Select this check box to select any object that is
just partly within the selection or lasso selection border.

CATURe 1~ Selection — Show Axes for 3D Movie Clips: When this check box is
S selected (the default) and you select a 3D movie clip, Flash displays the
X-, ¥-, and z- axes for the movie clip to give you an idea of how the movie
clip is oriented in 3D space.

Ng,

1~ Timeline — Span Based Selection: Lets you click between two
keyframes to select the entire section between them, a la Flash 5.

1~ Timeline — Named Anchor on Scene: Automatically creates a named
anchor at the beginning of each scene. (Named anchors enable viewers
to use the Web browser’s Back button effectively while navigating within
a Flash movie. This would be a great feature if it worked, but many
browsers don’t support it.)

1~ Highlight Color: Lets you specify the color of the box around selected
symbols and groups. You can select Use Layer Color to use the layer’s
outline color. Or click the color swatch to display all the available colors
and choose a different color for each kind of element listed (drawing
objects, drawing primitives, groups, symbols, and other elements).

1 Version Cue — Enable Version Cue: Select this option to use Adobe
Version Cue in Flash CS4. Version Cue is a version control and file-
sharing utility that lets you track and manage different versions of
your files.

1~ Printing — Disable PostScript: (For Windows only.) Selecting this
check box disables PostScript output when you print to a PostScript
printer. Select this check box only if you have trouble printing to a
PostScript printer.

ActionScript category

The ActionScript category (shown in Figure BC-2) offers settings relating to
the ActionScript Editor so that you can customize how ActionScript looks
and functions on the Actions panel:

1~ Editing: By default, any ActionScript that you type is automatically
indented. The tab size (amount of indentation) is four spaces. You can
remove the automatic indentation or change the tab size. Code hints
help you complete your code by providing pop-up text in the Actions
panel. You can remove these hints by deselecting the Code Hints
check box.

1~ Delay: You can drag the slider to set a delay before code hints are
displayed.

o
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Preferences
Category ActionScript
Ceneral
ActionSeript Ediing: W Automatic indentation
Ao Form at
Clipboard Tab size: |4
Drawing
Tewt ™ Code hints
Wamings
PSD File Im porter Delay: @ 0 seconds
&l File Importer
Font: | Monaco m 10 a
Shde: | Regular =
Openfimpon: | UTF-8 Encoding a
save/Export: | UTF-B8 Encoding B
Reload modified files. | Prompt B

Syrax colors: ¥ Code coloring

Foreground: | Background: |
Keywords: R Commeants: |
Identifiers: W Strings: |

Language: ( ActionSeript 2.0 Settings... )
(" ActionScript 3.0 Settings...

/_ Reset to Defaults

'K_Cancel_\ ok

Figure BC-2: Customize your preferences for formatting ActionScript.

1 Font: You can set the font type, size, and style in the ActionScript Editor.
For Windows only: Select the Use Dynamic Font Mapping check box to
have Flash substitute a font if the selected font family doesn’t have the
required glyphs (character shapes). Dynamic font mapping is generally
useful if you're working with multilingual text.

1 Open/Import: This specifies the encoding used for fonts when opening
or importing ActionScript (. as) files. The default, UTF-8, provides
Unicode encoding that supports multiple languages.

1~ Save/Export: This specifies the encoding used for fonts when saving or
exporting ActionScript (. as) files. The default, UTF-8, provides Unicode
encoding that supports multiple languages.

1~ Reload Modified Files: You can have Flash prompt you to reload modi-
fied ActionScript files or choose Never or Always options. Reloading files
keeps your ActionScript up to date.

1~ Syntax Colors: By default, ActionScript code is colored based on its
syntax. For example, comments are displayed in gray. You can remove
coloring or change the colors for each syntax type.

o
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1~ Language: You can put ActionScript in frames and in multiple separate
ActionScript text files, and you can also put ActionScript 2.0 in buttons
and movie clips. If you click the ActionScript 3.0 (or 2.0) Settings
button here, you can modify the places that Flash searches when
your ActionScript 3.0 (or 2.0) in one place references certain kinds of
ActionScript (called classes), which might be elsewhere. If you're just
starting out with Flash, you almost certainly are not defining new class
definition files in ActionScript — in which case, you don’t have to worry
about this.

Click the Reset to Defaults button to return all the settings in this category to
their defaults.

Auto Format category

This category, shown in Figure BC-3, offers specific options for formatting
ActionScript. Programmers are picky about how their code looks, and this
category lets you format your code the way you like. Select the various check
boxes; the preview pane shows the result.

Preferences
Category Auto Format
Gereral .
ActionSeript Insert { on line after if, for, switch, while, etc.
st Form at . ) i
Clipbaard [linsert { on line after function, class, and interface keywords

Drawing

Tesn

Wamings

BSD File Im porter
I File Importer [ Insert spaces around operators.

[ Don't cuddle } and else

[ Insert space after function name in function calls

[ Don't format multiline comments
Preview:

unction fix) £
I ot} £
i

retum 13
} elee {
reban ety
¥
3

/_ Reset to Defaults ) 'K_Cancel_\ ok )

Figure BC-3: Here you can dig into the details of how your ActionScript looks.
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Clipboard category

The Clipboard category enables you to set preferences for displaying,
exporting, and importing certain objects. Here are your choices, as shown
in Figure BC-4:

1~ Bitmaps — Color Depth: (For Windows only.) Specifies the color depth
for bitmaps copied to the Clipboard. You can choose to match the
screen or set a color depth from 4-bit to 32-bit with Alpha. You can use
this setting to reduce the size of bitmaps that you paste into Flash from
the Windows Clipboard.

1~ Bitmaps — Resolution: (For Windows only.) Sets the resolution of
bitmaps copied to the Clipboard. Select Screen to match your screen
resolution or select 72, 150, or 300. You can use this setting to reduce
the size of bitmaps you paste into Flash from the Windows Clipboard.

1~ Bitmaps — Size Limit: (For Windows only.) Lets you specify a size
limit in kilobytes for the amount of RAM (memory) used for a bitmap
on the Windows Clipboard. If you have large images, you might need
to increase this number, which is set to 250K by default.

Preferences
Category Clipboard
General
ActionSeript
Ao Form at PICT: -
Qlipboard Type: | Objects :
Drawing ‘Objects 4
Text . —
Wamings Resolution: (72 dpi
BSD File Im porter
Al File Importer ™ Include PostSeript

Gradient guality |~ Normal a

FreeHand text: [ Maintain as blocks

f Cancel_\ ok )

Figure BC-4: Specify settings for item copying and display on your
computer’s Clipboard.

o
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1 Gradient Quality: (For Windows only.) Lets you specify the quality of
gradients that you copy to the Clipboard for use in other applications.
Your options range from None to Best.

1 PICT Settings: (For Mac only.) Lets you specify the method and resolu-
tion used to copy art to the Clipboard. From the Type menu, select
Objects to copy art as vector graphics, or select one of the bitmap
settings to copy art as a bitmap. In the Resolution input box, type the
resolution you want in dots per inch. If you want to include PostScript
data, select the Include PostScript check box. In the Gradients menu,
select the Gradient quality you want when you paste the Clipboard into
a document outside Flash. (When pasting within Flash, this setting is
ignored, and you always get the full gradient quality.)

Drawing category

Click the Drawing category (shown in Figure BC-5) to set the following items:

Preferences
Category Drawing
General
ActionSeript (ml .
At Form at Pen tool Show pen preview
Clipboard ] r
Drawing Show solid points
Text | Show precise cursors
Wamings
PS5O File Im parter
41 File Importer Connect lines: | Normal =

Smooth curves: | Normal B
Recognize lines: | Normal F
Recognize shapes: (Normal @)

Click accuracy. | Normal 2]

¥ Bone tool [ Auto Set Transformation Point

'K_ Cancel \ %

Figure BC-5: Customize how your drawing tools work in Flash.
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1 FreeHand Text: By default, the Maintain Text as Blocks check box is
selected so that text pasted from FreeHand can be edited in Flash.

1 Pen Tool — Show Pen Preview: Displays a preview of the line or curve
segment before you click the next point. Recommended!

1~ Pen Tool — Show Solid Points: When marked, shows filled points at
vertices.

1~ Pen Tool — Show Precise Cursors: Displays a small crosshair rather
than the pen-shaped cursor, for more precise placement of points.

We cover the rest of the drawing settings in this category in Chapter 3.

Text category

The Text category, shown in Figure BC-6, allows you to specify your text
preferences, as follows:

Preferences

Category Text

General

ActionSeript =
Jasto Form at Font mapping defaul | _sans ﬁ
Clipboard
Drawing She: =
Tewt e
Wamings
PSD File Im porter Font mapping dizlog: W Show for missing fonts
& File Importer
Vertical text; || Default text orientation
" Right to left text flow
[ No kerning
Input method: | Text input window
ActionScript Editing: || Use ¥ key to insert | character
Forit menus. | Show non-Roman font names in English

# Show fant preview

Small B3

'K_Cancel_\ oK)

Figure BC-6: Specify various text preferences here.
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1 IK Bones Tool — Auto Set Transformation Point: If this check box is
selected (the default), Flash automatically positions the transformation
point for your IK Bone when you create one.

1~ Font Mapping Default: This is the default that Flash uses when you
open a movie that contains a font that you don’t have on your computer.
Select an option from the drop-down list.

+~ Font Mapping Dialog: If you enable this option, when you open a movie
that references fonts that aren’t on your computer, a dialog box appears
that lets you replace the missing fonts with fonts that you do have.

1~ Vertical Text — Default Text Orientation: Sets vertical text as the
default. Use this option for some Asian fonts.

1~ Vertical Text — Right to Left Text Flow: Sets text lines to flow from right
to left by default. This option is usually used for Arabic and Hebrew.

1~ Vertical Text — No Kerning: Removes kerning from vertical text.

1~ Input Method: For Windows, if you're working in Japanese, Chinese, or
Korean, select the appropriate language. For Mac, if you select the Text
Input Window check box, a separate text input window appears when
entering text in languages with very large character sets, such as
Japanese, Chinese, or Korean.

1 ActionScript Editing: (Mac only.) Some Japanese Mac keyboards have
no \ (backslash character). If you have a Japanese Mac keyboard,
you can select this check box to use the ¥ key to type a \ (backslash
character) when you're editing ActionScript.

1 Font Menus — Show Non-Roman Font Names in English: Non-roman
fonts are for languages such as Japanese, Chinese, Korean, and Arabic,
which don’t use the familiar Roman alphabet of A to Z. You can enable
this option to make font names easier to read if you can’t read non-
Roman alphabets.

1 Font Menus — Show Font Preview: When this option is enabled, the
font menus in Flash show a sample of each font, which can make it much
quicker for you to figure out which font you want to select. This option
is enabled by default.

Warnings category

As shown in Figure BC-7, the Warnings category lists 20 situations in which
Flash displays a warning message. All are enabled by default, so you're safe.
If you find these warnings annoying or unnecessary, deselect the appropriate
check boxes.
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Preferences
Category Warnings
(.lU'F"ﬂ_' )
i""::;‘r:"lﬂa‘l ™ Warn on save for Adobe Flash 8 or C53 compatibility
"
Clipboard ™ Warn on URL changes in launch and edit
Drawing
Tewt [ Warn on reading Generator content
Wamings

PSD File Im parter gw’arn on inserting frames when importing content

Al File Importer ™ Warn on encoding conflicts when expaorting ActionScript files

™ Warn on conversion of effect graphic objects

™ Warn on sites with overlapped root folder

™ Warn on behavior symbal conversion

™ Warn on symbaol conversion

E Warn on automatically converting from drawing object to group
™ Warn on automatically converting object to drawing object

B Show incompatibility warnings on feature controls

™ Warn on automatically generating ActionScript classes for timelines
M Warn on compiled clips defining ActionScript classes for symbols
™ Warn on converting multiple selection to symbal for tween

™ Warn on convert selection to symbol for tween

™ Warn on replacing current tween target

E Warn on mation frame contains ActionScript
[ YT 0N MULION GarYER UOJRGL Contam

At e rint

# Warn on IK bones not showing

IK_ Cancel \ m

Figure BC-7: You can turn on or off the display of assorted warning
messages in Flash.

PSD File Importer category

In the PSD File Importer category, shown in Figure BC-8, you can set prefer-
ences for the default settings for importing Photoshop documents:

~ Import Image Layers: You can choose to import image layers as bitmaps
with editable layer styles or as flattened bitmaps. You can also choose
whether to create movie clips to contain each imported image layer.

1~ Import Text Layers: You can import text layers as editable text, vector
outlines, or flattened bitmaps. And you can choose whether to create
movie clips to contain each imported text layer.

~ Import Shape Layers: You can choose to import shape layers with
editable paths and layer styles, or as flattened bitmaps. And again you
can choose whether to create movie clips to contain each imported
shape layer.

1~ Layer Groups: You can choose whether to create movie clips to contain
each layer group.

o
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1 Merged Bitmaps: You can choose whether to create movie clips to
contain each merged bitmap.

1 Movie Clip Registration: Click one of the nine dots that form the small
rectangle to specify the location of the registration point of any movie
clips that you create when importing the Photoshop document.

1+~ Publish Settings — Compression: You can specify whether to use lossy
or lossless compression (for potentially smaller file size or better image
quality, respectively) for the default Publish setting in the Photoshop
document importer. This Publish setting controls how the layers in
the Photoshop file are compressed when you publish your Flash file.
(See Chapter 13 for more on publishing your Flash files.)

1~ Publish Settings — Quality: If you choose Lossy as the Compression
preference, you can specify the default quality of that compression in
this setting. If you choose Use Publish Setting, Flash uses the level of
JPEG quality specified in the Flash tab of the dialog box that appears
when you choose Filer>Publish Settings. If you instead choose Custom,
you can specify a custom setting of JPEG quality, from 0 to 100.

Preferences
Category PSD File Importer
General i )
ActianSeript Select the default settings for the Photoshop document importer.
Ao Fomm at
-
e Import image lavers as: () Bitmap images with editable layer styles
Text @ Flattened bitmap images

Wamings . o
PSD File Im porter Create movie clips

&l File Importer
Impon tex layers as. () Editable text

() Vector outlines
@ Flattened bitmap images.
] Create movie clips

Impart shape layers as: () Editable paths and layer styles
®) Flattened bitmap images
) Create movie clips
Laver groups: || Create movie clips
Merged bitmaps: || Create movie clips

Movie clip registration: 388

Publish settings
Compression: | Lossy 'a

Quality (@) Use publish setting
() Custom: o

(_ Cancel \ %

Figure BC-8: Set your preferences for how Photoshop files are imported
into Flash.
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Al File Importer category

As shown in Figure BC-9, your choices for the defaults for the Adobe Illustrator
(A file importer are similar to the choices you have for the defaults for the
Photoshop file importer, described in the preceding section. In addition, you
can choose whether to show the Import dialog box before importing the
[llustrator file, whether to exclude objects outside the crop area of the file,
and whether to import hidden layers that are in the file.

Category

General
ActionSeript
Ao Fomm at
Clipboard
Drawing

Tew

Wamings

PSD File Im porter
Al File Importer

Al File Importer

Select the default settings for the lllustrator document importer.

GCeneral

Import text as:

Import paths as;

Images:

Groups:

Movie clip registration:

. ™ Show import dialog box

: [limport as bitmaps

W Exclude objects outside artboa
™ Exclude obj ide artboard
limport hidden layers

® Editable text

() Vector outlines

() Bitmaps

| Create movie clips

® Editable paths

() Bitmaps

[ Create movie clips

| Flatten bitmaps to maintain appearance
[ Create movie clips

"l import as bitmaps
" Create movie clips

" Create movie clips

(cancel ) 509

Figure BC-9: You can specify how you import Adobe lllustrator files into Flash.

Customizing Keyboard Shortcuts

You can create a shortcut for any menu item and change existing shortcuts.
(See the Cheat Sheet at the front of this book for commonly used keyboard
shortcuts.) Besides the standard set of shortcuts, Flash CS4 comes with
some built-in shortcuts based on other programs, including FreeHand 10,
[llustrator 10, and Photoshop 6 so that you can use those same familiar
shortcuts in Flash CS4.

o
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To create shortcuts, choose Edit=>Keyboard Shortcuts (Windows) or
Flashm>Keyboard Shortcuts (Mac) to open the Keyboard Shortcuts dialog
box. In Figure BC-10, the dialog box is displayed with the Drawing Menu
Commands option displayed in the Commands drop-down list.

s&N\BER

Re,

You can’t change the original set of shortcuts. Instead, create a duplicate set
of shortcuts and modify the duplicate. Give the duplicate a new name, such
as MyWay, and then use these shortcuts:

To duplicate a shortcut set, click the Duplicate Set button at the top of
the Keyboard Shortcuts dialog box.

To rename a set of shortcuts, click the Rename Set button at the top of
the Keyboard Shortcuts dialog box. (This option is not available until
you duplicate a shortcut set.)

To export a set of shortcuts as a Web page, click the Export Set as
HTML button at the top of the Keyboard Shortcuts dialog box. Then
you can use the Web page as a reference, to view your list of keyboard
shortcuts.

LRt

To delete a set of shortcuts, click the Delete Set button at the top of the
Keyboard Shortcuts dialog box.

&

Keyboard Shortcuts
Current set. [ Adobe Standard CIEIER N
Commands: | Drawing Menu Commands Q

File

Edit

Views '}
Insert

Modify

Text
Commands

Description

Shortcuts: nalll | Bl

Press key: Change

Cancel ) @

Figure BC-10: The Keyboard Shortcuts dialog box enables you to use
your fingers the way you want.
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When you have a new set of shortcuts, select from the Commands drop-down
list the types of commands that you want to change. You can change all eight
types of commands, but only one at a time:

1~ Actions Panel Commands: Changes shortcuts for working in the
Actions panel.

1 Debug Movie Commands: Changes shortcuts for commands from the
menus that appear when you are in a debugging session.

1 Drawing Menu Commands: Changes shortcuts for commands from the
default menus (the menus that appear when you are drawing, working in
the Timeline, and so on).

1~ Script Edit Commands: Changes shortcuts for commands from the
menu that appears when you are using the Script window. This is the
editor window that appears when you choose File>New (or File>Open)
and then choose a script file to edit, such as an ActionScript (. as) file or
a Flash JavaScript (. jsfl) file.

1~ Test Movie Menu Commands: Changes shortcuts for commands from
the menu that appears when you choose Control~>Test Movie.

 Timeline Commands: Changes shortcuts for commands that move and
select frames on the Timeline.

1~ Tools Panel: Changes shortcuts for the tools in the Tools panel.

1~ Workspace Accessibility Commands: Changes shortcuts for commands
that change the focus to the Stage or the Timeline, select panels, and
select objects within a panel.

For each type of command set, click the plus sign (+) in Windows or the
right-pointing arrow on the Mac on the list to display all the commands
and their current shortcuts. Here’s how to create a new shortcut:

1. Select the command that you want to customize.

2. Click the Add Shortcut button.

Flash adds a new shortcut, named empty.

+

3. Press the keyboard combination that you want to use.

You must include Ctrl (Windows)/8 (Mac), Alt (Windows)/Option (Mac),
or Shift before the second key. Flash tells you whether that combination
is already assigned to another shortcut.

e If you want to use that shortcut, click Change. Flash alerts you if
the shortcut is already taken and lets you reassign the shortcut.

o
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_ e [f you don’t want to use that shortcut, select the empty shortcut
from the Shortcuts list and click the Remove Shortcut button.

4. Repeat Steps 2 and 3 to change as many shortcuts as you want.

5. Click OK when you have finished changing shortcuts.

QP Until you get accustomed to your new shortcuts, create a list by clicking the
Export Set as HTML button, at the top of the Keyboard Shortcuts dialog box,
to save the list of new shortcuts in a Web page. Then print the Web page list-
ing your shortcuts and tape it to the side of your monitor or place it nearby
for easy reference.



